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Examining Standard Reports 
 
Based on interviews with key business users and analysts during the MERLIN requirements 
phase, several standard reports were developed to give users a quick start in using Cognos 
Impromptu (hereafter called Impromptu).   
 
The reports are set up to retrieve columns of commonly requested information.  After the user 
enters appropriate variables (e.g., agency, budget year, and accounting month) from a prompt 
window, Impromptu will retrieve the specified data.  Changing the format, deleting columns, 
removing detail, and modifying the filter can modify the report. 
 
Accessing standard reports 
  

• Select Open from File menu or click the Open button on the PowerBar. 
• Double click standard in the Directories Window. 
• Choose one of the subdirectories, i.e., budgets, finance, 2005 - Present Year Detail, 

workforce. 
 

 
 
• Click Open. 
• Select the file name of the report from the Open dialog box. 
• Choose Open. 
• Click OK when the Warning message appears 
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Examining the Open Dialog Box 
 

• When a report is selected, a preview of the report appears in the dialog box (if Preview is 
selected). 

  
• When you select the Fast Find check box, a list of specific directories appears in the 

Directory box.   
 

• When Filter by Catalog is selected, only those reports created with the currently active 
catalog appear. 

 
Completing the Prompt Dialog Box 
 
Each time you open a standard report, a Prompts dialog box opens automatically; and you are 
asked to enter data to filter the report.  Many of the prompts (such as choosing an agency) 
include a picklist.  A picklist makes filtering data easier, quicker and more accurate since you 
can display a scrollable list of values from which to choose.  Other prompts require you to type 
in a value (such as a vendor number or minimum amount). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To choose multiple items from a picklist, hold down the CTRL key, and then click each item you 
want to select.  To select a group of files that are next to each other, hold down the shift key and 
the mouse button. 
 
If you want multiple versions of the same standard report, simply click the Prompt button to 
reopen the Prompts dialog box to enter new variables. 
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Using Standard Reports 
 
It is important to become familiar with the standard reports that have been created for you as a 
starter set.  Close to 80 per cent of your reporting needs can be met with these reports or 
modifications to them.  The list below includes a brief description of each report.  
 
Budgets 
 
The reports in this section are based on detail transaction information. 
 
Commodity Expenditure 

An agency's commodity expenditure report for a budget year that is available through 
6/30/2014. 
 

Contractual Services, Detail 
An agency's contractual services expenditure report for a budget year that is available 
through 6/30/2014. 
 

Contractual Services, Summary 
An agency's contractual services expenditure report for a budget year that is available 
through 6/30/2014. 
 

Capital Outlay, Equipment 
An agency's capital outlay (equipment) expenditure report for a budget year that is 
available through 6/30/2014. 
 

Capital Outlay, Other 
An agency's capital outlay (other) expenditure report for a budget year that is available 
through 6/30/2014.   
 

Capital Outlay, Vehicles 
An agency's capital outlay (vehicles) expenditure report for a budget that is available 
through 6/30/2014. 
 

Capital Outlay, Wireless Communication Devices 
An agency's capital outlay (wireless communication devices) expenditure report for a 
budget year that is available through 6/30/2014. 
 

Out of State Travel Report for Budget Reporting 
An agency's out of state travel expenditure report from the travel ledger to be used for 
budget reporting that is updated daily. 
 

Out of State Travel Report from Travel Ledger 
An agency's out of state travel expenditure report for a budget year from SPAHRS detail 
expenditures that is updated daily.   
 

SAAS Out of State and Country Travel Report 
An agency's out of state and out of country travel expenditure report for a budget year 
from SAAS detail expenditures. 
 

Salary Report 
An agency's salary expenditure report for a budget year that is available through 
6/30/2014.  
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Travel Summary Report 

An agency's travel expenditure report for a budget year that is available through 
6/30/2014.    

 
Finance 
 
Appropriations 

 
Unobligated Balance YTD 

An agency’s appropriation balance after YTD expenditures and encumbrances are taken 
into account.  This report is available through 6/30/2014 and was built from a summary 
table. 
 

Uncommitted Balance YTD 
An agency’s appropriation balance after YTD expenditures, encumbrances, and pre-
encumbrances are taken into account. This report is  available through 6/30/2014 and 
was built from a summary table. 
 

Expenditures 
 
Agency Expenditures, Rpt Cat 

An agency’s expenditure information for a specific budget year and accounting month. 
This report is based on a summary that is available through 6/30/2014. 

 
Agency Expenditures YTD 

YTD expenditures for an agency for a specific budget year. This report was based on a 
summary that is available through 6/30/2014. 
 

Expenditures by Vendor 
Vendor expenditures for a specific budget year and accounting month.  This report was 
built from a weekly summary build and is available through 6/30/2014. 
 

Expenditures by $ 
An agency’s expenditures over a specified dollar amount for a specific budget year and 
accounting month.  This report was based on a summary that is available through 
6/30/2014. 
 

Vendor Expenditures by Agency 
An agency’s expenditure information for a specific vendor for a specific budget year and 
accounting month.  This report was built from a weekly summary build that is available 
through 6/30/2014. 
 

YTD Out of State Travel Report 
A year-to-date travel report for agencies, which provides all detail expenditures for out of 
state travel.  Provides the warrant number issued for a specified payment voucher. This 
report is updated daily. 
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Revenue 
 

Revenue by Agency YTD 
An agency’s YTD revenues for a specific budget year.  This report was built from a 
weekly summary build that is available through 6/30/2014. 

 
Revenue by Provider YTD 

An agency’s YTD revenue for a specific provider and budget year.  This report was built 
from a weekly summary build that is available through 6/30/2014. 

 
Revenue by $ YTD 
An agency’s YTD revenue over a specified dollar amount and for a specific budget year. 
This report was built from a weekly summary build that is available through 6/30/2014. 

 
2005 – PRESENT YEAR DETAIL 
The following reports are based on detail transaction information for budget years 2005 through 
2014. 
 
Provider Query by Agency 

All transactions for a specific agency and provider number by budget year for a range of 
accounting months.  
 

Transaction Detail Query 
Information related to a transaction for a specific agency. 
 

Vendor Query by Agency 
Transactions for a specific agency for a designated vendor number by budget year and a 
range of accounting months. 
 

Vendor Query by Transaction Type 
All transactions for a chosen transaction code (e.g., PV, CR) for a specific agency by 
budget year. 
 

Warrant Number Issued 
Provides the warrant number issued for a specified payment voucher transaction. 
 

Warrant Number Paid and Status 
Provides the warrant number issued and the status of the warrant for a specified 
payment voucher transaction.   

 
Warrant Number, Status 

Transaction information for a specific warrant number and the status of the warrant.  
 

Warrant Number 
Transaction information for a specific warrant number.   
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Workforce 
The reports in this section are based on information that is updated monthly. 
 
Agency Promotion Report 

Provides information detailing the employees who made job changes for a specific 
agency for a range of months  
 

Employee Listing 
Provides information regarding employees and their salaries employed by a specific 
agency for a designated as of month. 
 

Individual Promotion Report 
Provides job and salary history information for a specific employee, by social security 
number, for a range as of months.  

 
Race Sex Report 

Employee information including job name, job category, race and sex, for a specific 
agency for a designated as of month. 
 

Vacancy Report  
Job information related to vacant positions for a specific agency for a range of as of 
months. 

 
Modifying a Standard Report 
 
Frames are the building blocks of an Impromptu report.  A frame is a container that can hold 
data, text, pictures, or charts.  Objects are enclosed within those frames.  An Impromptu report 
consists of many types of frames. 
  

• A list frame for data details 
 

• A form frame for headers and footers 
 

• A picture frame within the header for the MERLIN seal 
 

• Text frames to display the title and labels for the data 
 
After a standard report has been retrieved, many modifications can be made to suit an 
individual’s reporting needs. 
 



 
4102 – MERLIN Standard Reports  V11 11/12/2015  

_____________________________________________________________________________________________ 
  Page 10 of 16 

 



 
4102 – MERLIN Standard Reports  V11 11/12/2015  

_____________________________________________________________________________________________ 
  Page 11 of 16 

Changing the Filter  
 
Filters, or selection criteria, can be changed to create the same report, but with different 
constraints.  For example, if you create one report to examine the current accounting month, 
you might want to create another report to examine the prior accounting month. To change a 
filter in a standard report: 
 

• Click the Prompt button on the PowerBar 
• Select the filter criteria 
• Click OK 

 
Creating Groups 
 
Grouping enables you to organize your data into logical chunks of information.  For example, 
you may want to group data by agency name so that you can easily view your data by agency. 
When you group data, your report won’t repeat duplicate values for the data item you’re 
grouping.  For example, if you group by agency name, by default the name of the product only 
appears once for all the entries in that group. To group data differently in a standard report: 
 

• Open the Query dialog box from the Report menu.  
• Select the Group tab 
• Select a column(s) to group 
• Click Group 
• Click OK 

 
Sorting Data 
 
Data can be sorted in alphabetical or numerical order.  You may want to change the sort order. 
For example, you may want to sort the Expenditures data item so that it displays expenditures in 
descending order showing the greatest expenditures first.  To sort data differently: 
 

• Open the Query dialog box from the Report menu.  
• Select the Sort tab 
• Select column(s) to sort 
• Click Ascending or Descending 
• Click OK 

 
Modifying Frames 
 
A number of frames have been inserted into your standard reports so that your reports will 
quickly have a very professional appearance.  Frames can easily be moved and details within 
the frame modified to suit your needs or preferences.  To edit title names or column names: 
 

• Double click the title or column title header 
• Edit the text 
• Click anywhere outside of text frame to terminate edit mode 
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Moving and Deleting Columns 
 
Standard reports have been created with numerous columns.  You might not want to include all 
of the columns.  To delete a column: 
 

• Move the cursor just above the column to delete (it changes to a down arrow) 
• Click the left mouse button 
• Press the Delete key on the keyboard 

 
Rearranging Columns 
 
Columns in standard reports can easily be rearranged.  To reorder columns: 
 

• Click either the Column Name or a value in the column 
• Hold the left mouse button down and drag to the appropriate location 
• Release the mouse button  

 
Reformatting Data Values 
 
Data values can be modified by adding $ signs or changing decimal precision. To reformat data: 
Select the data value to format 
 

• Choose Data from the Format menu 
 
Standard Report Exercises 
 
In the following exercises you will learn how to open existing Impromptu reports and enter 
variables in prompt windows to customize your report.  You will then modify the reports to suit 
your reporting needs.   

 
 
Exercise 1 
 
Using the Agency Expenditures, YTD standard report from the Training folder, create a report to 
examine expenditures for the Attorney General during 1997.  You will edit the report to include 
only a few of the columns, modify the title, and save it with a new name.  Your completed report 
should appear as shown. 
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1. Open Impromptu 

• Double-click the Impromptu icon on your desktop to launch the program 
• Enter your password 

 
2. Open the Agency Expenditures, YTD report and complete the Prompt 

• Select Open from the File menu or click the Open button on the Power Bar. 
• Ensure the directory path is set to C:\program files\cognos\cer6\MERLIN\reports. 
• Double click Training. 
• Select the Agency Expenditures, YTD report. 
• Click Open. 
• Complete the Prompt Dialog box as follows: 

Budget Year   1997 
Agency  ATTORNEY GENERAL 

• Click OK. 
• Scroll through the report pages using the arrows in the vertical scroll bar. 

 
3. Modify the column header of the report 

• Double click in the column header Total Bud Exp to change the text. 
• Type Total Expenditures in the column header. 
• Delete the original heading Bud Exp. 
• Press [ESC]. 

 
4. Delete columns except for those shown in the example on the preceding page. 
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5. Modify the title of the report  
• Click in the header. 
• Drag the frame vertically to make it large enough to hold another line of text. 
• Double click in the box to add text. 
• Type SFY 1997 in the header. 
• Press [ESC]. 

 
6. Save the report in the myreport directory and close the report 

• Choose Save As from the File menu. 
• Change file name to Attorney General Report. 
• Click OK to save the new report format. 
• Close the report using the File/Close command. 

 
7. Explore the PowerBar buttons 

• Move the mouse over the buttons on the PowerBar to read the descriptions of 
the buttons. 

• Click the Open button on the PowerBar. 
 
8. Examine other options 

• Select the report you just created.  Note the report preview. 
• Click Open to display the report. 
• Use the Help/Search for Help on command to look up information on the topic of 

printing. 
• Close the report. 

 
Exercise 2 
 
Using the Vendor Expenditures by Agency, Training standard report in the Training folder, 
create the following vendor expenditure reports. 
 
1. Create a report for vendors beginning with “BIG” 

• Click the Open button on the PowerBar. 
• Select Vendor Expenditures by Agency, Training. 
• Click OK to display the prompt window. 
• Complete the Prompt Dialog box as follows: 

Budget Year    1997 
Accounting Month   08 
Agency   Archives and History 
Vendor name   BIG 

• Click OK. 
• Examine the report. 

 
2. Now create a report for the vendor SMITH GEORGE 

• Click the Prompt button on the PowerBar. 
• Change the Prompt Dialog box as follows: 

Budget Year    1997 
Accounting Months  06, 07 & 08 
Agency    Education 
Vendor name   SMITH GEORGE 

• Click OK and examine the report. 
• Close the report without saving it. 
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Exercise 3 
 
Using the Expenditures by $ standard report from the Standard folder, create a report to 
examine expenditures exceeding $3,000 for the State Auditors Office for January 1997.  Sort 
the expense amount in descending order and group the report by Major Object Code.  Your 
report should appear as shown below. 
 

 
 
1. Open the Expenditures by $ standard

• Click the Open button on the PowerBar. 
 report and complete the prompt. 

• Select Expenditures by $. 
• Click Open to display the prompt window. 
• Complete the Prompt Dialog box as follows: 

Budget Year    1997 
Accounting Month   07 
Agency Group   AUDITORS OFFICE  
Minimum Amt   3000 

• Click OK. 
 
2. Sort the data in the report by Budget Expenditure Amount in descending order. 

• Open the Query dialog box from the Report menu. 
• Select the Sort tab. 
• Select Bud Exp. 
• Click Descending. 
• Click OK. 
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3. Now, rearrange and delete columns and modify the header to tailor the report. 
• Delete columns except for those shown on the above example. 
• Move Major Obj and Minor Obj columns to the second and third positions. 

 
4. Group the data by Major Object Code. 

• Open the Query dialog box from the Report menu. 
• Select the Group tab. 
• Select Major Obj Code.  
• Click Group. 
• Select Minor Obj Code. 
• Click Group. 
• Click OK. 

 
5. Modify your report to show expenditures for Human Services and Mental Health.  

• Click the Prompt button on the PowerBar. 
• Change the Prompt Dialog box as follows: 

Budget Year     1997 
Accounting Month    07 
Agency Group  HUMAN SERVICES, MENTAL HEALTH 
Minimum Amt    100000 

• Click OK. 
 
6. Your report should appear as shown below. 

• Close the report without saving it. 
 
 

 
 


	Examining Standard Reports
	Accessing standard reports
	Examining the Open Dialog Box
	Completing the Prompt Dialog Box

	Using Standard Reports
	Budgets

	Commodity Expenditure
	Contractual Services, Detail
	Contractual Services, Summary
	Capital Outlay, Equipment
	Capital Outlay, Other
	Capital Outlay, Vehicles
	Capital Outlay, Wireless Communication Devices
	Out of State Travel Report for Budget Reporting
	Out of State Travel Report from Travel Ledger
	SAAS Out of State and Country Travel Report
	Salary Report
	Travel Summary Report
	Finance
	Appropriations

	Unobligated Balance YTD
	Uncommitted Balance YTD
	Expenditures

	Agency Expenditures, Rpt Cat
	Agency Expenditures YTD
	Expenditures by Vendor
	Expenditures by $
	Vendor Expenditures by Agency
	YTD Out of State Travel Report
	Revenue

	Revenue by Provider YTD
	Revenue by $ YTD
	2005 – PRESENT YEAR DETAIL

	Provider Query by Agency
	Transaction Detail Query
	Vendor Query by Agency
	Vendor Query by Transaction Type
	Warrant Number Issued
	Warrant Number Paid and Status
	Warrant Number, Status
	Warrant Number
	Workforce

	Agency Promotion Report
	Employee Listing
	Individual Promotion Report
	Race Sex Report
	Vacancy Report
	Modifying a Standard Report
	Changing the Filter
	Creating Groups
	Sorting Data
	Modifying Frames
	Moving and Deleting Columns
	Rearranging Columns
	Reformatting Data Values

	Standard Report Exercises
	Exercise 1
	Exercise 2
	Exercise 3


